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IMPORTANT NOTICE

All statements, technical information, and recommendations in this document which relate to the products supplied
by Meggitt SA are based on information believed to be reliable, but unless otherwise expressly agreed in writing
with Meggitt SA the accuracy or completeness of such data is not guaranteed. Before using this product, you must
evaluate it and determine if it is suitable for your intended application. You should also check our website at
www.meggittsensing.com/energy for any updates to data sheets, Ex certificates, product drawings, user manuals,
service bulletins and/or other instructions affecting the product.

Unless otherwise expressly agreed in writing with Meggitt SA, you assume all risks and liability associated with use
of the product. Meggitt SA takes no responsibility for any statements related to the product which are not contained
in a current English language Meggitt SA publication, nor for any statements contained in extracts, summaries,
translations or any other documents not authored and produced by Meggitt SA.

The certifications and warranties applicable to the products supplied by Meggitt SA are valid only for new products
purchased directly from Meggitt SA or from an authorised distributor of Meggitt SA.

Meggitt SA reserves the right to alter any part of this publication without prior notice.

EXPORT CONTROL
The information contained in this document may be subject to export control regulations of the European

Community, USA or other countries. Each recipient of this document is responsible for ensuring that the transfer or
use of any information contained in this document complies with all relevant export control regulations. ECN N /A.

COPYRIGHT
Copyright © 2019 Meggitt SA
All rights reserved
Published and printed by Meggitt SA in Fribourg, Switzerland

The names of actual companies and products mentioned
herein may be the trademarks of their respective owners.

The information contained in this document is subject to change without notice.
This information shall not be used, duplicated or disclosed, in whole or in part,
without the express written permission of Meggitt SA.
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PREFACE

About these release notes

This document provides important information about the VibroSight® software from Meggitt SA. It is applicable to all
VibroSight-based condition monitoring systems using the versions of software described by this document, namely:

¢ VibroSight software version 4.1.0 (CD part number 609-004-000-047).

This document contains information about changes to the software since the previously released version
(VibroSight 4.0.0), such as new features and improvements, solved problems and bug fixes, and hardware and
software compatibility.

For more general information on the actual software, or the entire condition monitoring system (CMS), refer to the
following Meggitt SA documentation:

m- .
Ziinl V|brOS|ght® software data sheet
(Doc. ref. 660-020-005-218A)

<= Getting started with VlbroS|ght® installation guide
(Doc. ref. 660-010-006-226A)

@ VibroSight® help

= I o .
<=1 VM600 XMV16 / XIO16T extended vibration monitoring card pair data sheet
(Doc. ref. 660-020-010-208A)

“~| VibroSight application notes and technical notes.

Users who are familiar with VibroSight may also find it useful to refer to the release notes included in earlier
versions of the software:

¢ VibroSight 4.0.0 (Doc. ref. 660-010-013-227A)
¢ VibroSight 3.8.0 (Doc. ref. 660-010-013-226A)
¢ VibroSight 3.7.0 (Doc. ref. 660-010-013-225A)
¢ VibroSight 3.6.0 (Doc. ref. 660-010-013-224A)
¢ VibroSight 3.5.0 (Doc. ref. 660-010-013-223A)
¢ VibroSight 3.4.0 (Doc. ref. 660-010-013-222A)
¢ VibroSight 3.3.0 (Doc. ref. 660-010-013-221A)
¢ VibroSight 3.2.0 (Doc. ref. 660-010-013-220A)
¢ VibroSight 3.1.0 (Doc. ref. 660-010-013-219A)
¢ VibroSight 3.0.0 (Doc. ref. 660-010-013-218A)
¢ VibroSight 2.12.7 (Doc. ref. 660-010-013-217A)

¢ VibroSight 2.12.6 (Doc. ref. 660-010-013-216A)
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¢ VibroSight 2.12.5 (Doc. ref. 660-010-013-215A)
e VibroSight 2.12.4 (Doc. ref. 660-010-013-214A)
¢ VibroSight 2.12.3 (Doc. ref. 660-010-013-213A)
e VibroSight 2.12.2 (Doc. ref. 660-010-013-212A)
e VibroSight 2.12.1 (Doc. ref. 660-010-013-211A)
e VibroSight 2.12.0 (Doc. ref. 660-010-013-210A)
¢ VibroSight 2.11.6 (Doc. ref. 660-010-013-209A)
e VibroSight 2.11.5 (Doc. ref. 660-010-013-208A)
¢ VibroSight 2.11.4 (Doc. ref. 660-010-013-207A)
e VibroSight 2.11.3 (Doc. ref. 660-010-013-206A)
¢ VibroSight 2.11.2 (Doc. ref. 660-010-013-205A)
e VibroSight 2.11.1 (Doc. ref. 660-010-013-204A)
¢ VibroSight 2.11.0 (Doc. ref. 660-010-013-203A)
e VibroSight 2.10.1 (Doc. ref. 660-010-013-201A)
¢ VibroSight 2.10.0 (Doc. ref. VIBROSIGHT-RN/E)
e VibroSight 2.9.7 (Doc. ref. VIBROSIGHT-RN/E)
¢ VibroSight 2.9.6 (Doc. ref. VIBROSIGHT-RN/E)
e VibroSight 2.9.5 (Doc. ref. VIBROSIGHT-RN/E)
¢ VibroSight 2.9.4 (Doc. ref. VIBROSIGHT-RN/E)
e VibroSight 2.9.2 (Doc. ref. VIBROSIGHT-RN/E)
¢ VibroSight 2.9.1 (Doc. ref. VIBROSIGHT-RN/E)

¢ VibroSight 2.9.0 (Doc. ref. VIBROSIGHT-RN/E).

Structure of the release notes

This document presents information in the following order: general items first, then in terms of the software
modules that constitute VibroSight, such as @ Configurator, B Event Viewer, Ei Mimic, G Scope, B
Server, @ System Manager and @ Vision.

You should read those sections that are most relevant to you and then keep the document for future reference.
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Version identifiers
A complete VibroSight software version number has four components that provide the following information:
* X.X.X.X, major release identifier — typically incremented once per year.

e X.X.X.X, minor release identifier — incremented for each release with typically four scheduled releases per
year.

e X.X.X.X, “hotfix” release identifier — 0 for a normally scheduled release and incremented for each hotfix
release.

e X.X.X.X, software build number — for internal use.

For each scheduled release of VibroSight, at least one of the first two digits changes (x.x.x.x).
For unscheduled “hotfix” releases, which are occasionally required to solve urgent problems, the third digit changes
(X.X.X.X).

The version identifiers for installed software appear in the Help About box (obtained using Help > About ... in any
VibroSight software module).

Terminology

To distinguish between the different Meggitt SA products that can be used with the VibroSight® software, the
following terminology is used in this document:

¢ VMG600 card — to refer to the VibroSight-software compatible cards that are installed in a VM600 rack. The
currently available VM600 cards that are designed for operation with the VibroSight software are the
XMx16 card pairs (XMC16 / XIO16T, XMV16 / XIO16T and
XMVS16 / XIO16T) and the CPUx card pairs (CPUR2/IOCR2 and CPUR/IOCR).

Where XMx16 card is used in this document, it refers to XMC16 / XIO16T, XMV16 / XIO16T and XMVS16 /
XIO16T cards, unless otherwise stated.

Where CPUXx card is used in this document, it refers to CPUR2/IOCR2 and CPUR/IOCR cards, unless
otherwise stated.

e VibroSmart® module or VibroSmart® device — to refer to VibroSight-software compatible modules or devices
that are used in a distributed monitoring system. The currently available VibroSmart modules and devices
that are designed for operation with the VibroSight software are the VSI010, VSN010 and VSV30x.

Where VibroSmart module is used in this document, it refers to the VSI010 and VSV30x modules, unless
otherwise stated.

Where VibroSmart device is used in this document, it can refer to the VSNO010 device only, or to the VSI010
and VSV30x modules and the VSNO10 device, unless otherwise stated.

Document reference VIBROSIGHT-RN/E (660-010-013-228A)
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1 Llicensing

Since VibroSight 4.0.0, the ability to install and run VibroSight software updates and upgrades depends on the
purchased “Updates and support” package.

NOTE: VibroSight 4.1.0 is a minor level release and a new license key file is not required
for updates and upgrades from VibroSight 4.0.x.

However, a new license key file is required for updates and upgrades from
VibroSight 3.8.x or earlier.

For further information on licensing or to obtain a new VibroSight license key file, contact Meggitt SA customer
support. See 7 Customer support.

2 Features

General

2.1 VM600 XMV16 support for rolling-element bearing analysis

VibroSight 4.1.0 adds support for early fault detection and diagnosis of rolling-element bearings using vibration
signal analysis with either an advanced demodulation (envelope) signal analysis technique and/or simple crest
factor measurements.

NOTE: VibroSight rolling-element bearing analysis can be used with VM600 XMV16 cards
only.

Rolling-element bearings are used in many machines in industry, from small to large. Although well understood and
designed to last for many years, in practice, less than 10% of all rolling-element bearings reach the expected age
according to their design parameters. This is often a result of the bearings not being treated correctly, for example,
due to inadequate lubrication, incorrect installation and/or overload. So ultimately, these bearings are responsible
for many machinery issues and should be monitored accordingly.

Inherent to their design, problems with rolling-element bearings are characterised by impacts between the rolling
elements and imperfections on the race/ring surfaces that result in low-amplitude high-frequency waveforms that
can be monitored by a suitable condition monitoring system.

NOTE: Rolling-element bearings produce low-amplitude high-frequency waveforms. The
high frequencies require that these bearings are monitored using accelerometers.

Document reference VIBROSIGHT-RN/E (660-010-013-228A)
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VibroSight supports rolling-element bearing analysis in one of two ways:

e Vibration signal analysis with a demodulation (envelope) signal analysis technique
This is a complex and detailed analysis that uses the existing auxiliary waveform for a dynamic processing
block in order to generate a dedicated demodulation spectrum, then frequency-specific demodulation data and
measurements that are related to particular rolling-element bearing defects/failures frequencies.
Accordingly, demodulation (envelope) signal analysis can detect defects/failures in rolling-element bearings at
the earliest possible opportunity, thereby allowing maintenance intervals and operational efficiency to be
optimised.

e Vibration signal analysis with crest factor measurements
This is a simple indicative analysis that uses the existing auxiliary waveform for a dynamic processing block in
order to calculate the crest factor, a measurement that indicates an overall increase in the higher-frequency
components that are related to general deterioration in a rolling-element bearing.
Accordingly, crest factor measurements can detect defects/failures in rolling-element bearings that have
already developed, that is, much later than demodulation (envelope) signal analysis.

VibroSight runs both types of rolling-element bearing analysis, separately or simultaneously, at the VibroSight
Server level, that is, it is post-processing performed by the VibroSight Server on the data ((auxiliary) spectra and
waveforms) received from the Dynamic processing blocks configured for a VM600 XMV16 card.

Rolling-element bearing failure frequencies

Due to their underlying geometry, there are a number of characteristic defect/failure frequencies associated with a
rolling-element bearing:

e Ball pass frequency of inner race/ring (BPFI), sometimes also known as Frequency inner race defect (Firp)
e Ball pass frequency of outer race/ring (BPFO), sometimes also known as Frequency outer race defect (Forp)

e Ball spin frequency (BSF), sometimes also known Frequency ball defect (Fgp)
Note: Fgp = ( BSF x 2), as the ball defect hits both the inner and outer races during one rotation.

e Fundamental train frequency (FTF), sometimes also known Frequency cage (F¢).

Rolling-element bearing failure frequencies - formulae
BPFI = RPMx (Ng/2)x(1+(Bp/Pp)(cos@))
BPFO = RPM x (Ng/2)x(1-(Bp/Pp)(cos@))

BSF = (RPM/2)x (Pp/Bp)x(1-((Bp/Pp)(cos@))?)

FTF = (RPM/2) x(1-(Bp/Pp)(cos@))

Where

RPM is the rotational speed of the bearing (machine)
Ng is the number of balls (rolling elements)

Bp is the ball (rolling element) diameter

Pp is the bearing pitch diameter

@ is the contact angle.

Document reference VIBROSIGHT-RN/E (660-010-013-228A)
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NOTE: These formulae are applicable to rolling-element bearings using ball or cylindrical
rollers.

So knowing the bearing (machine) speed and the underlying bearing geometry, the expected defect/failure
frequencies can readily be calculated. It is worth noting that most bearing manufacturers make such information
freely available on their websites under bearing frequencies (calculator), bearings analysis or similar.

When these defect/failure frequencies become noticeable in the vibration spectrum, they indicate that there are
defects within that particular component of the bearing. Further, characteristic spectra (patterns) indicate specific
defects and problems such as inner race failure, outer race failure, rolling-element failure and train failure.
Accordingly, these defect/failure frequencies should be monitored in order to support early fault detection and
diagnosis of rolling-element bearings.

NOTE: BPFI is typically 4X to 10X, BPFO is typically 2X to 7X, BSF is typically 1.5X to 3X.
and FTF is typically 0.38X to 0.42X, where X is the rotational speed (RPM) of the
bearing.

Crest factor measurements

As bearing problems develop with the passing of time, the amplitudes of all of the individual characteristic
defect/failure frequencies associated with a rolling-element bearing gradually increase until they can be detected
using:

e Crest factor (CF) — the ratio of the peak value to the effective value of a waveform.

Crest factor measurements - formula
CF = ( |WFPEAK | /WFRMS )

Where
| WFpeak | is the peak amplitude of the waveform (signal)
WFgys is the root mean square (RMS) value of the waveform (signal).

NOTE: Higher crest factor values indicate larger peaks relative to the average energy
content of the signal.
For example, a sine wave has a crest factor of 1.414 (V2 ) and a direct current (DC)
signal has a crest factor of 1.

For a healthy rolling-element bearing, crest factor measurements are initially low as there are no significant peaks
in the vibration measurement (that is, no impacts between the rolling elements and imperfections on the race
surfaces).

Document reference VIBROSIGHT-RN/E (660-010-013-228A)
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As the rolling-element bearing becomes damaged, the crest factor increases as there will be peaks in the vibration
measurement (that is, due to impacts between the rolling elements and imperfections on the race surfaces).

As a rolling-element bearing becomes more and more damaged and reaches the end of its life, the crest factor
then decreases as although there are still peaks, the RMS value of the vibration measurement increases
significantly.

To use rolling-element bearing analysis with VMé00 XMV 14 cards

e VibroSight Configurator is used to configure the vibration measurement channels of a VM600 XMV16 card for
rolling-element bearing analysis — demodulation (envelope) signal analysis and/or crest factor measurements —
including any required alarms.

e The VibroSight Server is used to enable or disable the rolling-element bearing analysis performed by the
VibroSight Server.

e VibroSight Vision is used to display and analyse the resultant rolling-element bearing data using the usual
plots.

To configure rolling-element bearing analysis — using demodulation (envelope) signal analysis
In VibroSight Configurator:

1. Create a new VibroSight Server configuration containing a VM600 XMV16 card (File > New > VibroSight
Server configuration) or open and modify an existing one (File > Open > ... (*.vscfg)).

2. Inthe Hardware view, at the XMV16 card node level, under Processing blocks, for a Dynamic processing
block, select the Spectra and waveforms node.
The parameters window (centre) updates to display the parameters for the Spectra and waveforms.

3. Inthe parameters window (centre) for the Spectra and waveforms, under Waveform and spectrum
processing, select the Auxiliary mode tab and under Demodulation spectrum, configure the following
parameters:

Name: Use the default name for the demodulation spectrum (“Dynamic Processing Block
n_DemodulationSpectrum”) or change it, as required.

Output state: The demodulation spectrum is Disabled by default but must be Enabled when rolling-element
bearing analysis is required.

Note: When demodulation (envelope) signal analysis is being used, the (auxiliary) demodulation spectrum must
be Enabled, the Physical quantity must be configured as Acceleration for the associated Dynamic input
channel, the Sampling mode must be configured as Fixed frequency and the Bandwidth must be greater than
the demodulation spectrum’s high-pass filter for the associated Dynamic processing block. In addition, the
auxiliary waveform must be enabled for the associated Dynamic processing block (also on the Auxiliary mode
tab of the Spectra and waveforms node).
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Use full display custom values: Select to allow custom minimum and maximum amplitude values and units
(Max full display and Min full display) to be associated with the demodulation spectrum in VibroSight.

High pass filter: Enter the cutoff frequency for the high-pass filter above which the high-frequency
defect/failure frequencies for the rolling-element bearing are expected to appear.

Note: The default frequency is 2 kHz but will depend on the underlying geometry of the rolling-element bearing
and the speed of the machine.

Max full display: Custom maximum amplitude value and units to be associated with the demodulation
spectrum in VibroSight.

Min full display: Custom minimum amplitude value and units to be associated with the demodulation spectrum
in VibroSight.

4. Also in the parameters window (centre) for the Spectra and waveforms, under Waveform and spectrum
processing, under the Auxiliary mode tab and Acquistion, configure the following parameter:
Update rate: Select an update rate for the demodulation spectrum (Auxiliary mode tab data).
Note: The default update rate is 1 hour but can be increased to a maximum of 1 minute, if required.

5. Inthe Hardware view, at the Dynamic processing block node level for the Spectra and waveforms configured to
generate a demodulation spectrum, right-click the Dynamic processing block then click New Demodulation
extraction.

The parameters window (centre) updates to display the parameters for the Demodulation extraction.

6. Inthe parameters window (centre) for the Demodulation extraction (scalar data), under Demodulation
extraction, configure the following parameters.
Under Demodulation extraction:
Name: Use the default name for the demodulation data (“Demodulation Extraction n”) or change it, as required.
For example, to BPFI, BPFO, etc.
Extraction state: The demodulation data is Enabled by default but can be Disabled, as required.
Main frequency: Enter the expected frequency for this defect/failure for the rolling-element bearing.
Note: The frequency for a particular defect/failure (BPFI, BPFO, etc) is typically available from the bearing
manufacturer’s website or can be calculated from the bearing (machine) speed and the underlying bearing
geometry. It is important to note that these frecuencies are not completely accurate due to slip, wear or
imperfections, and small variations are usually encountered.
Harmonics: Enter the number of harmonics of the main frequency to be included in the calculation of the
demodulation data.
Note: The default number of harmonics is 5.
Side bands at: Enter the expected frequency for the side bands, if any, associated with this particular
defect/failure for the rolling-element bearing.
Note: If there are no sidebands, a value of 0 (zero) should be used. This is the default value.
Note: Side bands are associated with certain defects/failures, notably BPFI and BSF.
Side bands: Enter the number of side bands, if any, to be included in the calculation of the demodulation data.
Qualifier: Select the qualifier (rectifier) to use for the calculation of the demodulation data.
Under Full display range:
Use custom values: Select to allow custom minimum and maximum amplitude values and units (Maximum
value and Minimum value) to be associated with the demodulation data.
Maximum value: Custom maximum amplitude value and units to be associated with the demodulation data in
VibroSight.
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Minimum value: Custom minimum amplitude value and units to be associated with the demodulation data in
VibroSight.

Under Alarms:

Allows alarms to be configured for the demodulation data.

In the Data storage view, configure the data logging and event logging (Data logging) of the VibroSight Server
in the usual way.

Note: If data logging rules are not configured for the data generated for rolling-element bearing analysis
(demodulation spectrum and/or demodulation data), then the data will be available as live data only.

Create and activate the VibroSight Server in the usual way (File > Save as > Server / database, then File >
Apply changes to running configuration).

To configure rolling-element bearing analysis — using crest factor measurements

In VibroSight Configurator:

1.

Create a new VibroSight Server configuration containing a VM600 XMV16 card (File > New > VibroSight
Server configuration) or open and modify an existing one (File > Open > ... (* .vscfqg)).

In the Hardware view, at the XMV16 card node level, under Processing blocks, for a Dynamic processing
block, select the Spectra and waveforms node.
The parameters window (centre) updates to display the parameters for the Spectra and waveforms.

In the parameters window (centre) for the Spectra and waveforms, under Waveform and spectrum
processing, select the Auxiliary mode tab and under Waveform, configure the following parameters:

Output state: The auxiliary waveform is Disabled by default but must be Enabled when rolling-element bearing
analysis is required.

Note: When crest factor measurements are being used, the auxiliary waveform must be Enabled and the
Physical quantity must be configured as Acceleration for the associated Dynamic input channel.

Also in the parameters window (centre) for the Spectra and waveforms, under Waveform and spectrum
processing, under the Auxiliary mode tab and Acquistion, configure the following parameter:

Update rate: Select an update rate for the auxiliary waveform (Auxiliary mode tab data).

Note: The default update rate is 1 hour but can be increased to a maximum of 1 minute, if required.

In the Hardware view, at the Dynamic processing block node level for the Spectra and waveforms configured to
generate an auxiliary waveform, right-click the Dynamic processing block then click New Crest factor
extraction.

The parameters window (centre) updates to display the parameters for the Crest factor extraction.

In the parameters window (centre) for the Crest factor extraction (scalar data), under Demodulation
extraction, configure the following parameters.

Under Demodulation extraction:

Name: Use the default name for the crest factor measurement (“Crest Factor Extraction n”) or change it, as
required.

Extraction state: The crest factor measurement is Enabled by default but can be Disabled, as required.
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Under Full display range:

Use custom values: Select to allow custom minimum and maximum amplitude values and units (Maximum
value and Minimum value) to be associated with the crest factor measurement.

Maximum value: Custom maximum amplitude value and units to be associated with the crest factor
measurement in VibroSight.

Minimum value: Custom minimum amplitude value and units to be associated with the crest factor
measurement in VibroSight.

Under Alarms:

Allows alarms to be configured for the crest factor measurement.

In the Data storage view, configure the data logging and event logging (Data logging) of the VibroSight Server
in the usual way.

Note: If data logging rules are not configured for the data generated for rolling-element bearing analysis
((auxiliary) waveform and/or crest factor data), then the data will be available as live data only.

Create and activate the VibroSight Server in the usual way (File > Save as > Server / database, then File >
Apply changes to running configuration).

NOTE: Although they use the same underlying auxiliary waveform (for a Dynamic input

channel), crest factor measurements are completely independent of demodulation
(envelope) signal analysis.

To enable rolling-element bearing analysis (demodulation (envelope) signal analysis and/or crest factor
measurements) on a VibroSight Server

In the VibroSight Server user interface:

1.

2.

On the Status tab, under Device drivers, ensure that VM600 is enabled.
On the Status tab, under Server features, ensure that Rolling element bearing is enabled.

On the Status tab, under Server features, ensure that Data logging manager is enabled if the VibroSight
Server is required to log data to its data repository.
Note: If the VibroSight Server is to be used for the display of live data only, then data logging is not required.

Once a configuration is activated (applied) to the VibroSight Server and the required device drivers and server
features are enabled, the measurement data becomes available from the VibroSight Server.
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To display rolling-element bearing analysis (demodulation (envelope) signal analysis and/or crest factor
measurements) data and measurements in VibroSight Vision

VibroSight Vision is used to display rolling-element bearing analysis data and measurements in the usual way.
In VibroSight Vision:

1. Create a new VibroSight Vision project (File > New project) or open and modify an existing one (File > Open
> ... (*.vsvision)), then select and connect to the VibroSight Server.

2. Using the Machinery view or Hardware view to select the measurement or measurements to display.

3. Using the Time Range to select live data or historical data (and the time period of interest for historical data).

Application tips and tricks

Rolling-element bearings produce low-amplitude high-frequency waveforms that should be monitored using
accelerometers and the amplitude of the vibration signal measured at the sensor is highly dependent on the sensor
position and the mounting method.

It is not possible to know the level/state of rolling-element bearing damage based on the amplitude of the failing
frequencies but it is possible based on the defect/failure frequencies. Accordingly, demodulation (envelope) signal
analysis provides a much wider range of diagnostic capability than crest factor measurements.

2.2 GSD file for VMé600 CPUR2 card available directly from card

The GSD file for a VM600 CPUR2 card (PNR 600-026-000-VVV) is now available directly from the card itself using
VibroSight System Manager.

NOTE: A general station description (GSD) file is a device description file provided with
PROFIBUS and PROFINET devices. It is a text file that contains information about
the basic capabilities and characteristics of a PROFIBUS or PROFINET device,
and must be provided with the device.

With a GSD file, system integrators can determine basic data such as the
communications options and the available diagnostics, and the supervision
software (PROFIBUS or PROFINET “master” device) can plan the configuration of
the system.
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To download a GSD file from a VM600 CPUR2 card
In VibroSight System Manager:

1. Select the CPUR2 card module from the Devices tree-view of the System Explorer.
Note: As an IP address can be easily changed, a VM600 card such as a CPUR2 should be identified by its
serial number (XXXXXXX).
The Actions window of the System Manager will show the available tools. If you cannot see the Actions
window, click View > Actions.

2. Click Download GSD file under Maintenance in the Actions window and use the resultant Save As dialog box
to indicate in which folder and under what name the GSD file (* . txt) should be saved. Then click Save.

3. Click OK to close the message and continue.

The VM600 CPUR2 card’s GSD file is typically imported by third party devices such as a DCS or PLC in order to
help configure their communications links with the CPURZ2’s fieldbus interfaces.

Downloading the VM600 CPUR2 GSD file directly from the CPUR card after a firmware upgrade is useful in order
to ensure that the latest correct version of the GSD is being used for the card.

VM600 CPUx card firmware and GSD files

The different versions of the VM600 CPUx card (CPUR2 and CPUR) have their own distinct firmware and GSD
files:

e Forthe CPUR2 card (PNR 600-026-000-VVV), the GSD file can be downloaded directly from the card itself and
is also available from the firmware folder on the computer running VibroSight.

e Forthe CPUR card (PNR 600-007-000-VVV), there is no GSD file as the CPUR does not support PROFIBUS
or PROFINET.

NOTE: The default firmware and GSD files directory for VM600 CPUR2 cards is:
C:\Program Files\Meggitt\VibroSight\Firmware\VM600\CPUR2

The default firmware file directory for VM600 CPUR cards is:
C:\Program Files\Meggitt\VibroSight\Firmware\VM600\CPUR

NOTE: The default location for the Windows program files folder depends on the operating
system installed on the computer:
*C:\Program Files is used for 64-bit programs and applications.
*C:\Program Files (x86) Is used for 32-bit programs and applications.
As a result, all references to the program files folder may need to be adapted by
removing or adding (x86) as required.
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VM600 cards

2.3 CPUR2 card: new firmware

The VM600 CPUR2 card (PNR 600-026-000-VVV) firmware has been improved with the following improvements:

Overall performance, responsiveness and stability.

CPUR2/I0OCR2 card pair relays (RL1 and RL2) are now configurable via Modbus, that is using the
Fieldbus configuration file thatis uploaded to the CPUR2 card using VibroSight Configurator.

(Previously, the CPUR2/IOCR2 card pair’s relays were unavailable for use.)

Fieldbus configurations containing enabled serial fieldbuses (Modbus RTU) are no longer accepted, that is,
they cannot be uploaded to the CPUR2 card using the Fieldbus configuration file in VibroSight
Configurator. More specifically, the Fieldbus configuration file can still contain RTUx sections but any
RTUXx sections must be disabled (for example, [RTU1] .. ENABLE = NO ).

(Previously, fieldbus configurations with enabled serial fieldbuses were accepted but not acted upon as
Modbus RTU was never supported by the CPUR2.)

CPUR2 GSD file is now available directly from the card itself, that is, downloadable using VibroSight
System Manager. See 2.2 GSD file for VM600 CPUR2 card available directly from card.

Some limitations in configurations removed:
o Number of heartbeat registers ( heartbeats ) is how unlimited (previously, was limited to 5 max.)
o Number of freeze registers ( freeze ) is now unlimited (previously, was limited to 5 max.)

o Number of status delay registers ( status_delay ) is now unlimited (previously, was limited to
5 max.).

Earlier/legacy Modbus speed channel configuration fields removed: TRD/TRN/NWE and update tacho .

See also 5.2.1 Card firmware.

2.4 CPUR card: new firmware

The VM600 CPUR card (PNR 600-007-000-VVV) firmware has been improved with the following bug fixes:

VM600 CPUXx time counter wraparound (overflow) bug that affected time-related functions such as timers,
delays, watchdogs and polling rates.

Status of relay outputs now included in the diagnostics logs (files).

See also 5.2.1 Card firmware.
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3 Solved problems and bug fixes

3.1 General improvements and bug fixes

General stability improvements and bug fixes across the VibroSight 4.1.0 software.

3.2 VM600 XMx16 cards: configuration containing a dynamic processing block with fixed-
frequency sampling incorrectly allowed time-domain averaging to be configured

For VM600 XMx16 condition monitoring cards, a configuration containing a Dynamic processing block configured
to use fixed-frequency sampling (Resampler settings, Sampling mode: Fixed frequency) without a tachometer
(Resampler settings, Reference speed: Blank) incorrectly allowed time-domain averaging to be configured
(Averaging, Time domain processing selected) even though such a configuration results in erroneous waveform
data.

A tachometer is required for such a configuration and this is now enforced by the VibroSight Configurator
Consistency check.

3.3 VibroSmart VSV30x modules: configuration containing disabled relays prevented
communications with the VibroSight Server

For VibroSmart® VSV30x monitoring modules, a configuration containing relay outputs configured as disabled
(Module, Outputs, Relay, State: Disabled) prevented communications between the VSV30x module and its
VibroSight Server, while communications between other VibroSmart modules in the same configuration and the
VibroSight Server continued to operate normally.

Associated VibroSight Server message (Log messages):
VibroSmart module driver: Error running driver for module xxxxxxxxx. The given key

was not present in the dictionary.

See also 3.4 VibroSmart VSV30x modules: configuration containing disabled modules prevented the correct
operation of the VibroSight Server.

3.4 VibroSmart VSV30x modules: configuration containing disabled modules prevented the
correct operation of the VibroSight Server

For VibroSmart® VSV30x monitoring modules, a configuration containing modules configured as disabled
(Module, State: Disabled) prevented correct operation of the VibroSight Server.

Associated VibroSight Server message (Log messages):
VibroSmart module driver: Error running driver for module xxxxxxxxx. The given key

was not present in the dictionary.

See also 3.3 VibroSmart VSV30x modules: configuration containing disabled relays prevented communications
with the VibroSight Server.
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3.5 Problems displaying cursors in the Time trend of Spectrogram plots in VibroSight Vision

When using VibroSight Vision to display the Time trend (Projection) associated with a Spectrogram plot, the
cursors in the Time trend were not displayed incorrectly, that is, the cursor could be displayed not touching the data
curve and the horizontal cursor could be displayed when no data was available.
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4 Known issues

4.1 Display of timestamps in VibroSight Vision

In VibroSight Vision, when the timestamps (date and time) are configured to be displayed as Site time or Local
computer time and the site time or local computer time is subsequently changed on the relevant computer (for
example, using Windows > Control Panel > Date and Time), this change is not reflected in the VibroSight Vision
user interface until the user clicks on the Timestamp displayed in the VibroSight Vision status bar.

4.2 VibroSight Server and Host Service restart required after changes to network adapter

If the configuration of a network adapter is changed (for example, enabled or disabled, connected or disconnected)
on a computer running VibroSight, then the VibroSight Servers and Host Services running on the computer must
be restarted in order for the network adapter to be recognized by the VibroSight discovery mechanism.

4.3 Length limitation of VibroSight Server instance names

Since VibroSight 2.9.6, VibroSight Server instance names are limited to 18 characters, whereas up to
27 characters were allowed in previous versions. This constraint is enforced during the creation of new server
instances with VibroSight 2.9.6 or later.

NOTE: VibroSight allows only alphanumeric characters (A to Z, ato z, 0 to 9), the
hyphen-minus character ( - ) and the underscore character (_) to be used for
VibroSight Server names.

However, existing server instances may be non-compliant (too long) and no longer run after an upgrade of the
VibroSight software. In such cases, the file names used for a VibroSight Server database file (* . vssrvdb or

* . db) and a VibroSight Server configuration file (* . vssrvcfg or *. config) should be updated (and manually
edited in the VibroSight configuration file) to be 18 characters or less. Changes may also be required in any
VibroSight software that references the server instance name, such as VibroSight Vision projects.

Where used, the automated data management commands and operations that append a timestamp
(_yyyyMMddHHmMmsSs) to the Server instance name reduces the number of file name characters that remain
available for VibroSight Server instance names to three. Alternatively, the server instance name can be shorted
after the data repository command or operation is complete.

Also, depending on the VibroSight Server data repository (database) file names used and any truncation performed
by VibroSight, it is possible that servers are created with names that contain non-allowed characters (such as
spaces), with the result that these servers will not be accessible by VibroSight software clients. Similarly, duplicate
VibroSight Server names are also possible.
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NOTE: Choose appropriate VibroSight Server names in order to avoid name conflicts
arising due to truncation and/or additional data repositories being created during
automatic data management.

This is particularly important for systems with automated data management and
system backup procedures that can generate VibroSight Server data repositories
with different file names.

4.4 Display of timestamps in VibroSight clients other than VibroSight Vision

Although VibroSight Vision now supports the display of timestamps (date and time) as either Site time, UTC time or
Local computer time, all other VibroSight client software modules continue to display timestamps in local computer
time only (that is, the date and time according to the local clock of the computer running the VibroSight software
module).

4.5 Display of devices in VibroSight System Manager

In the System Explorer window of VibroSight System Manager, the Devices tree-view does not always update
correctly to show all of the devices (VM600 cards and VibroSmart devices) available on the network.

In particular, this has been seen when changing the firmware of a device, and can persist even after a refresh
(using the Refresh toolbar button or View > Refresh).

If this behaviour is seen, the recommended workaround is to:
¢ Wait a few minutes and refresh again.

¢ Restart VibroSight System Manager.

4.6 VibroSight Mimic backwards compatibility

VibroSight 2.10.0 contained significant improvements and changes, including a separate VibroSight Mimic client
software module for mimics (that were previously available in VibroSight Vision). As a result, VibroSight Vision
mimics created with VibroSight 2.9.7 or earlier are not compatible with VibroSight 2.10.0 or later.

VibroSight 2.11.0 contained significant improvements and changes to the VibroSight Mimic client software module.
As a result, VibroSight Vision mimics created with VibroSight 2.10.1 or earlier are not compatible with VibroSight
2.11.0 or later.

VibroSight 2.11.5 contained significant improvements to the VibroSight Mimic project framework to include version
information, in order to improve the compatibility between projects created with different versions of VibroSight
Mimic and eliminate the requirement for the recreation of Mimics. Starting with VibroSight 2.11.5, Mimic projects
automatically detect any changes in the VibroSight Mimic software that affect project compatibility, inform the user
and update the project as required.
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NOTE: VibroSight 2.11.5 is also able to open and work with Mimic projects created with
VibroSight 2.11.0 or later, if the corresponding database had been updated as
required.

NOTE: When updating existing machinery monitoring projects created with

VibroSight 2.12.x to VibroSight 3.x.x or later, a new data repository created by
copying a VibroSight database (* . vssrvdb) to a VibroSight historical data folder
(* . vshdf) must use the same server file name as the existing server in order for
existing VibroSight Mimics to maintain links with the data repository and continue to
work (without manual corrections).

In addition, the VibroSight Server using the new data repository must be running
before the existing VibroSight Mimics are run for the first time, after the update.

4.7 VibroSight OPC Clients not recovering

When a VibroSight OPC Client is being used to import information from an external OPC server into a VibroSight
system and the external OPC server becomes unavailable, the VibroSight OPC Client may not always recover
automatically when the OPC server becomes available again.

This is typically characterised by the VibroSight OPC Client continuing to show connection error messages even
when OPC server is available and can result in permanent loss of the imported data if not noticed.

NOTE: The external OPC data can be permanently lost if it is not imported into VibroSight
as expected.

Any VibroSight system feature or configuration element relying on the imported
OPC data will not behave as expected, for example, alarms, machinery operating
conditions and data logging rules.

If this behaviour is seen, the recommended workaround is to:

e Stop and restart the VibroSight OPC Client from either the VibroSight Server
(Data > Acquisition > OPC Device Driver) or VibroSight System Manager.

e Stop and restart the VibroSight Server, if required.

4.8 Duplicate events

For VibroSight systems using VM600 XMx16 cards, VibroSight Event Viewer retrieves all of the event information
available from the data buffers on the cards.

For VibroSight systems using VibroSmart modules, VibroSight Event Viewer retrieves the event information
available from the current time only (no buffered events).
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Accordingly, for a VibroSight system using VM600 XMx16 cards, there is the possibility of duplicate events being
listed in the Event Viewer, particularly for VibroSight systems being operated without an NTP server (where events
are not recognised as duplicates due to time drift).

4.9 VibroSight Server status indicators

The status indicators (performance counter monitors) on the Status tab of the new VibroSight Server are not
correctly displayed and updated when an NVIDIA WMI driver is installed on the same computer as the VibroSight
Server.

NOTE: The NVIDIA Enterprise Management Toolkit (NVWMI) is a graphics and display
management and control technology that interfaces to Microsoft's Windows
Management Instrumentation (WMI) infrastructure, specific to NVIDIA graphics
processing units (GPUS).

This is because NVIDIA WMI prevents the Microsoft .NET Framework from obtaining the required counter values
from the underlying operating system / computer.

4.10 XMx16 card pre-logging

For an XMx16 card pair, if Dynamic Input Channel 16 is used as an input to a Dynamic Processing Block that is
used as an input to a Dual Shaft Relative Processing Block which is configured to provide an Orbit and/or Full
Spectrum output, then any pre-logging configured for the principal mode Waveform and/or Spectrum of Dynamic
Input Channel 16 will not actually log any of the data from the same pre-logging scope.

4.11 Problems creating new VibroSight OPC Classic Servers

Users who have upgraded from an earlier version of VibroSight to a later version (for example, from
VibroSight 2.x.x or 3.0.0 to VibroSight 3.1.0) can experience problems when creating new VibroSight OPC Classic
Servers.

Such problems are typically characterised by the OPC Server Create command in VibroSight System Manager
displaying an error message such as
“The type initializer for ‘ch.VibroMeter.Xms.OpcServer.Utils.OpcServerUtils’ threw an

L
exception .

This typically occurs because an earlier version of the OpcServer.config file required by VibroSight OPC
Classic Servers is being used by the later installation of VibroSight, which can happen in one of two ways:

e When a version of VibroSight 3.x.x or later is installed on a computer that was running a version of
VibroSight 2.x.x or earlier, the VibroSight installer automatically checks existing VibroSight folders (such as
C:\ProgramData\Meggitt\VibroSight 2) in order to copy relevant system and/or user preference files across to
the new VibroSight folders (such as C:\ProgramData\Meggitt\VibroSight), including an earlier
OpcServer.config file.
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e When VibroSight 3.1.0 is installed on a computer that was running VibroSight 3.0.0, the creation of a
VibroSight OPC Classic installer using VibroSight 3.0.0 automatically created an earlier OpcServer.config
file.

As shown below, the first few lines of a typical OpcServer. config file contains version specific information that is
incompatible with later versions of VibroSight:

<?xml version="1.0" encoding="utf-8"?>
<configuration>
<configSections>

<section name="opcServersConfiguration"
type="ch.VibroMeter.Xms.OpcServer.Utils.OpcServersSystemConfiguration, XmsOpcServerUtils,
Version=2.0.0.0, Culture=neutral, PublicKeyToken=2db2a2387bacl0ala" />

</configSections>

</configuration>

So for users who have upgraded from an earlier version of VibroSight to a later version, if problems are
experienced when creating new VibroSight OPC Classic Servers, the workaround is to:

1. Use an XML-compatible text editor program to edit the OpcServer.config file and remove the version specific
information. That is, change the line containing the section name
from:

<section name="opcServersConfiguration"
type="ch.VibroMeter.Xms.OpcServer.Utils.OpcServersSystemConfiguration, XmsOpcServerUtils,
Version=2.0.0.0, Culture=neutral, PublicKeyToken=2db2a2387bacl0ala" />

to:

<section name="opcServersConfiguration"
type="ch.VibroMeter.Xms.OpcServer.Utils.OpcServersSystemConfiguration, XmsOpcServerUtils,
Culture=neutral, PublicKeyToken=2db2a2387bac0ala" />

2. Restart the computer.
Note: The computer must be restarted to ensure that the edited version of the OpcServer.config

file is used (and not some other version from cache memory).

3. Use the OPC Server Create command in VibroSight System as required.
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NOTE: The manual migration of existing VibroSight OPC Classic Servers to
VibroSight 3.x.x or later is described in detail in the “VibroSight OPC Classic Server

migration” section of the latest =] Getting started with VibroSight installation
guide.

412 Potential TCP port 50000 conflict

The VibroSight Host Service (XmsHostService.exe) requires TCP port 50000 for communication with the
VibroSight software. So if the computer running the VibroSight software is running other software which also
requires TCP port 50000, this results in a TCP port conflict which can prevent VibroSight (or the other software)
from running.

During the VibroSight software installation process, the VibroSight 3.4.x or later installer will typically detect other
software on the computer that is using TCP port 50000 and report this. For example: “The port 50000 cannot be
used. Please close all application using this port before manually starting the host service.”

Accordingly, any potential TCP port 50000 conflicts should be resolved before the VibroSight software can be
successfully installed and run.

4.13 Problems using shared network drives/locations for VibroSight data management

On computers running Windows 10 or Windows Server 2016, problems can be experienced using shared network
drives/locations with VibroSight's integrated data management operations such as Offline data storage and
Database backup (configured in VibroSight Configurator) due to Windows security policies and restrictions.

Such problems are typically characterised by the individual copy commands scheduled and run on a VibroSight
Server (corresponding to Offline data storage and Database backup operations) failing to run correctly. More
specifically, on the Data Management tab of a VibroSight Server, scheduled incremental copy jobs (Type: Copy)
are typically displayed with Status: Error, while the Log Messages tab of the server display typically displays
messages such as “Errors during the copy operation”and “Uncaught error IOException
occurred in task ‘Task “DataRepositoryCopyDataMan..”.

NOTE: For Windows 10 and Windows Server 2016, Microsoft improved network security
with a change to the rules governing shared network drives/locations.
More specifically, a shared network drive/location is now only accessible and
visible to the user who created the shared network drive/location, even if the user is
an Administrator.

Accordingly, in order to avoid such problems, a shared network drive/location on Windows 10 and

Windows Server 2016 computers that is required to be used by VibroSight’s integrated data management
operations should be created as a “system account” in order to ensure that the required Windows Services can
access the shared resource (drive/location).
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This can easily be done using Microsoft's PsExec utility. For example, by running the following command (as an
Administrator):

PsExec.exe -1 -s cmd.exe /C "net use Z: \\server\share"

Where the net use command is used to map the \\computer name\sharename (\ \server\share) to the
devicename (Z:).

NOTE: For Windows 10 and Windows Server 2016, Microsoft improved network security
with a change to the rules governing shared network drives/locations.
More specifically, a shared network drive/location is now only accessible and
visible to the user who created the shared network drive/location, even if the user is
an Administrator.

414 Problems installing VibroSight 3.7.x on computers without internet access

On computers which are not connected to the internet, the VibroSight 3.7.x installer can experience problems when
automatically installing the prerequisite Microsoft Visual C++ Redistributable Package for Visual Studio 2015, and
report a generic message such as “Setup Failed. One or more issues caused the setup to fail”.

As a workaround, trying to manual install the Microsoft Visual C++ Redistributable Package for Visual Studio 2015,
the Microsoft Visual C++ installer can also experience problems, and report a similar generic “Setup Failed”
message.

This is a known Microsoft problem which is due to some components in Visual Studio being signed by a
certification authority that is not installed on the computer, and the computer cannot automatically download the
required certificate(s) because it is hot connected to the internet.

Accordingly, the Microsoft solution is to:

1. On acomputer which is connected to the internet, download the following certificate:
http://www.microsoft.com/pki/certs/MicRooCerAut2011_2011 03_22.crt
Then copy the certificate to the VibroSight computer (for example to C:\Temp).

2. On the VibroSight computer, use the certmgr.exe utility to add the certificate by using the command line.
Note: For more information, refer to the Certmgr.exe (Certificate Manager Tool) topic at MSDN.

3. Open an admin command prompt and run the following command:
certmgr.exe /add C:\Temp\MicRooCerAut2011 2011 03_22.cer /s /r localMachine root

4. Next, try installing the patch KB3135996 or KB3136000.

If required, additional information is available from a Microsoft MSDN blog, here:
https://blogs.msdn.microsoft.com/vsnetsetup/2016/03/28/a-certificate-chain-could-not-be-built-to-a-trusted-root-

authority-2
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5 Compatibility

As part of the VibroSight software installation process, the VibroSight installer will automatically check to see if the
required Microsoft .NET Framework, Microsoft Visual C++ Redistributable Package, OPC Core Components
Redistributable software and OPC UA Local Discovery Server are pre-installed on the computer:

e The required Microsoft Visual C++ Redistributable Package (see section 5.1.3) must be manually installed
before VibroSight can be installed. If it is not detected, then the VibroSight installer will exit the installation and
VibroSight is not installed.

e The required Microsoft .NET Framework (see section 5.1.2) is automatically installed by the VibroSight installer
if it is not detected.

e The required OPC Core Components Redistributable (see section 5.1.4) software is automatically installed on
the computer by the VibroSight installer if it is not detected.

e The required OPC UA Local Discovery Server (see section 5.1.5) software is automatically installed on the
computer by the VibroSight installer if it is not detected.

NOTE: Refer to the latest version of the = Getting started with VibroSight installation

guide or the =1 VibroSight software data sheet for further information on
VibroSight's prerequisites and compatibility.

5.1 VibroSight software
VibroSight 4.1.0 is a minor level release and replaces VibroSight 4.0.0.

Compatibility with existing VibroSight data repositories (databases) is achieved using a specific data migration
process from any existing databases based on Sybase SQL Anywhere (*.vssrvdb) to data repositories based on
the VibroSight historical data repositories (VibroSight historical data folder (* . vshdf) for operation with a
VibroSight Server (live data) and VibroSight historical data archive (* . vshda) for operation with historical data).

Compatibility with existing VibroSight machinery monitoring projects using VibroSight OPC Servers that were
created using VibroSight 2.12.7 or earlier is achieved using a specific VibroSight OPC Server migration process for
these VibroSight OPC Servers.

Therefore, it is important to note that:

e New machinery monitoring projects created with VibroSight 4.x.x (VibroSight 3.x.x or later) will automatically
use VibroSight historical data repositories.

e Existing machinery monitoring projects created with versions of VibroSight earlier than VibroSight 3.0.0 must
be manually migrated from Sybase SQL Anywhere databases to VibroSight historical data repositories before
they can be used with VibroSight 4.x.x (VibroSight 3.x.x or later).

e Existing machinery monitoring projects using VibroSight OPC Servers that were created with versions of
VibroSight earlier than VibroSight 2.12.7 must manually migrate their VibroSight OPC Servers before they can
be used with VibroSight 4.x.x (VibroSight 3.x.x or later).

It is very important to note that migrating a VibroSight OPC Server from VibroSight 2.12.7 or earlier to
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VibroSight 4.x.x (VibroSight 3.x.x or later) or later requires that certain steps must be performed using the
existing version of VibroSight (that is, VibroSight 2.12.7 or earlier) BEFORE it is removed (uninstalled).

NOTE: The manual migration of an existing machinery monitoring project to
VibroSight 4.x.x (VibroSight 3.x.x or later) or later is described in detail in the
“Data migration” and “VibroSight OPC Server migration” sections of the latest

#~| Getting started with VibroSight installation guide.

5.1.1 Microsoft Windows operating systems

VibroSight 4.x.x (VibroSight 3.x.x or later) or later is compatible with 32-bit versions and 64-bit versions of
Microsoft ® Windows © operating systems.

NOTE: Starting with VibroSight 3.0.0, VibroSight software is now available as 64-bit
software for 64-bit Windows and 32-bit software for 32-bit Windows.
The 64-bit version of VibroSight can be installed on 64-bit Windows computers
only. The 32-bit version of VibroSight can be installed on 32-bit Windows
computers only. Only a single version of VibroSight can be installed and exist on a
computer at any one time

See the Appendix of these release notes for further information on VibroSight software and Windows operating
system compatibility.

5.1.2 Microsoft .NET Framework

For most Windows operating systems, VibroSight 4.x.x (VibroSight 3.7.0 or later) requires that the Microsoft .NET
Framework 4.7.2 or later is installed.

NOTE: VibroSight 4.x.x requires Microsoft .NET Framework 4.7.2.

If the required Microsoft .NET Framework is not pre-installed, then the VibroSight installer will detect this and
automatically install it as part of the VibroSight software installation process.

See the Appendix of these release notes for further information on VibroSight software and Microsoft .NET
Framework requirements.

5.1.3 Microsoft Visual C++ Redistributable Package

VibroSight 4.x.x (VibroSight 3.x.x or later) requires that the Microsoft Visual C++ Redistributable Package for Visual
Studio 2015 is installed, in order to install and register the Visual C++ libraries used by VibroSight.

NOTE: The 64-bit version of the Microsoft Visual C++ Redistributable Package (“Microsoft
Visual C++ 2015 Redistributable (x64)”) must be installed on 64-bit Windows
computers.

The 32-bit version of the Microsoft Visual C++ Redistributable Package (“Microsoft
Visual C++ 2015 Redistributable (x86)”) must be installed on 32-bit Windows
computers.
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If the required Microsoft Visual C++ Redistributable Package is not pre-installed, then the VibroSight installer will
detect this and exit the installation.

5.1.4 OPC Core Components Redistributable

VibroSight 4.x.x (VibroSight 3.x.x or later) requires that the OPC Core Components Redistributable is installed, in
order to configure and run VibroSight OPC Clients and VibroSight OPC Servers correctly: the redistributable must
be installed on OPC client computers in order to allow connections to remote OPC servers and it must be installed
on OPC server computers in order to allow OPC clients to browse for running OPC servers.

NOTE: The 64-bit version of the OPC Core Components Redistributable (“OPC Core
Components Redistributable (x64) 106.0”) must be installed on 64-bit Windows
computers.

The 32-bit version of the OPC Core Components Redistributable (“OPC Core
Components Redistributable (x86) 106.0”) must be installed on 32-bit Windows
computers.

If the required OPC Core Components Redistributable is not pre-installed, then the VibroSight installer will detect
this and automatically install it as part of the VibroSight software installation.

5.1.5 OPC UA Local Discovery Server

VibroSight 4.x.x or later requires that the OPC UA Local Discovery Server is installed, in order to expose OPC UA
servers for discovery and enable communications with OPC UA clients.

If the required OPC UA Local Discovery Server is not pre-installed, then the VibroSight installer will detect this and
automatically install it as part of the VibroSight software installation.

5.1.6 Sybase SQL Anywhere 11 software
VibroSight 4.x.x (VibroSight 3.x.x or later) does not include any Sybase SQL database software.

Starting with VibroSight 3.0.0, the VibroSight historical data repositories (VibroSight historical data folder
(* . vshdf) for operation with a VibroSight Server (live data) and VibroSight historical data archive (* . vshda) for
operation with historical data) are exclusively used for the required data repositories.

A VibroSight database based on Sybase SQL Anywhere (* .vssrvdb) can no longer be used as a data repository.
Accordingly, the Sybase SQL Anywhere 11 database software is no longer included and distributed as part of the
VibroSight software.
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NOTE: VibroSight 3.x.x or later exclusively uses data repositories based on the VibroSight
historical data system.

VibroSight 2.12.7 used data repositories based on Sybase SQL Anywhere
databases and introduced initial support for working with data repositories based
on the VibroSight historical data repositories for data analysis.

VibroSight 2.12.6 or earlier exclusively used data repositories based on Sybase
SQL Anywhere databases.

NOTE: The manual migration of an existing machinery monitoring project to
VibroSight 4.x.x (VibroSight 3.x.x or later) is described in detail in the “Data

migration” section of the latest =] Getting started with VibroSight installation
guide.

5.1.7 Dell Backup and Recovery software

Some Dell™ computers running versions of Dell Backup and Recovery software can experience problems running
the VibroSight software, characterised by the VibroSight software not running or running incorrectly. This is
because the Dell Backup and Recovery software can use a version of SQLite and associated libraries (DLLS) that
prevent the VibroSight Host Service from running correctly.

For example, VibroSight clients can stop running (crash), VibroSight clients can be unable to connect to data
sources and/or VibroSight System manager may not display all of the commands expected to be available in the
Actions window.

If this behaviour is seen, the recommended workaround is to uninstall the Dell Backup and Recovery software.

NOTE: It is recommended to install and use VibroSight 3.x.x or earlier on a computer that
does not have Dell Backup and Recovery software installed.

5.1.8 MatrikonOPC software
Both MatrikonOPC™ software and the VibroSight software can be installed and run on the same computer.

However, if the MatrikonOPC software is installed after the VibroSight software, this can result in problems related
to credentials (access rights). These problems are typically characterised by an unhandled exception in VibroSight
Configurator when trying to configure an OPC device in the Hardware view or an unhandled exception in a
VibroSight Server when trying to handle/process OPC data.

MatrikonOPC software and the VibroSight software must be installed on the same computer in the following order:
1. Install the MatrikonOPC software.

2. Install the Microsoft Visual C++ Redistributable Package for Visual Studio 2010 (version 40219).
Note: This redistributable package is required by the MatrikonOPC software.
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3. Install the Microsoft Visual C++ Redistributable Package for Visual Studio 2015 (version 23026 or later).
Note: This redistributable package is required by the VibroSight software.

4. Install VibroSight 3.x.x or later.
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5.2 VM600 cards

5.2.1 Card firmware

There are some firmware upgrades for VM600 cards corresponding to VibroSight 4.1.0.

The latest firmware for the CPUR2 card is now:
e Base System: base-system-640-014-001-003.tgz
e Applications: applications-640-015-001-003.tgz.

See 2.3 CPUR2 card: new firmware for details of improvements to this latest CPUR2 firmware.

The latest firmware for the CPUR card is now:
e Base System: base-system-640-011-001-005.tgz
e Applications: applications-640-012-001-005.tgz.

See 2.4 CPUR card: new firmware for details of improvements to this latest CPUR firmware.

NOTE: In order to help distinguish between VM600 CPUXx cards, VibroSight 4.x.x uses
the following terminology:
* CPUR2 to refer to the latest version of the CPUx card with support for
PROFIBUS (PNR 600-026-000-VVV).
* CPUR to refer to the earlier version of the CPUx card with support for
Modbus RTU/TCP and card pair redundancy (PNR 600-007-000-VVV).

(Previously, VibroSight 2.12.7 to 3.8.x used CPUR to refer to the CPUx card with
PROFIBUS but VibroSight 4.x.x now refers to this card as the CPUR2.)

The latest firmware for the XMC16, XMV16 and XMVS16 cards remains:
e Base System: base-system-640-003-001-016.tgz

e Applications: applications-640-010-001-016.tgz.

Therefore, for current versions of VM600 cards, firmware upgrades may be required depending on the application.
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5.3 VibroSmart devices

5.3.1 Module firmware

There are no firmware upgrades for VibroSmart modules and devices corresponding to VibroSight 4.1.0.

The latest firmware for the VSI010 module remains:

e 642-002-000-010.xmsifw.

The latest firmware for the VSNO010 device remains:

e 642-004-000-011.redboxfw.

The latest firmware for the VSV30x modules remains:

e 642-001-000-016.xtranfw.

Therefore, for current versions of VibroSmart modules and devices, firmware upgrades are not required.
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6 Upgrade procedure

This section describes the procedure for upgrading a VibroSight system from a previous version. Perform the steps
in the given sequence in order to complete a system upgrade.

NOTE: It is strongly recommended to verify the version of firmware running in the related
hardware (XMx16 cards and VibroSmart modules and devices) before starting a
VibroSight system upgrade, in order to establish if any firmware updates are also
required.
See 6.2.3 Updating the firmware using VibroSight System Manager.

NOTE: It is strongly recommended to ensure that a copy of the configuration for a
VibroSmart is available before updating the firmware of any of the VibroSmart
modules used in the distributed monitoring system. See 6.2.3 Updating the
firmware using VibroSight System Manager.

6.1 VibroSight software user settings

The VibroSight Software generates and uses some files on the storage device of the computer running VibroSight
to keep track of user-configurable settings, so that these settings are remembered and applied for the VibroSight
installation.

These settings files have an . xmssettings file name extension and on a computer running Windows 7, can be
found here:

C:\Users\username\AppData\Roaming\Meggitt\VibroSight, where username is the Windows account name.

For example, the vibroSightVision.xmssettings file records the user-configurable default settings for
VibroSight Vision, such as default settings for plots.

NOTE: VibroSight software updates and upgrades do not replace these settings files, so:
» For a computer on which VibroSight was previously installed, an update, upgrade
or a re-installation of VibroSight will continue to use the previous defaults recorded
in the . xmssettings files.
 For a computer on which VibroSight was not previously installed, the installation
of VibroSight will generate and use new . xmssettings files, which use the latest
VibroSight software defaults.

If a settings file is deleted for any reason, VibroSight will generate and use a new
settings file, which uses the latest VibroSight software defaults.
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6.2 Updating VibroSight-compatible hardware

Appropriate files and tools are included in the installation package to allow VM600 cards (XMx16) and VibroSmart
devices (VSI010, VSNO010 and VSV30x) to be updated to the latest firmware, in order to take advantage of
improvements to the VibroSight software.

Updating the firmware VM600 cards or VibroSmart devices is a special task that can, if used unintentionally or
incorrectly, lead to malfunctioning of the device and affect proper function of data acquisition.

During the firmware update of a device, the card or module being updated cannot provide its normal machinery
monitoring functions because its outputs (alarms and relays) can go to undetermined states, irrespective of how
they have been configured.

For VibroSmart modules, the machinery being monitored is not protected for the duration of a firmware update and
the restart (reboot) that is triggered automatically after the firmware update (which can take up to 5 minutes).

NOTE: It is highly recommended that firmware updates are only performed in accordance
with the operating procedures for the machinery being monitored and that
appropriate precautions are taken at the control system level (such as DCS
or PLC).

For example, alarms and relay outputs should be ignored (bypassed or inhibited) in
order to avoid false trips of the machinery being monitored.

6.2.1 VM600 card firmware

The latest VM600 card firmware files are copied to a directory on your computer as part of the VibroSight software
installation process.

NOTE: For example, the default firmware directory for VM600 cards is:
C:\Program Files\Meggitt\VibroSight\Firmware\VM600

The firmware files for a VM600 card can be found in the appropriate subfolder and identified by their .tgz file name
extension. For example, the xMv16 subfolder contains the applications and base system firmware for use by
XMV16 cards. Any additional firmware updates received from Meggitt SA should also be stored in these
directories.

Table 1 shows the compatibility between VibroSight software and VM600 CPUR?2 card hardware (that is, CPUR2
firmware).

Table 2 shows the compatibility between VibroSight software and VM600 CPUR card hardware (that is, CPUR
firmware).

Table 3 shows the compatibility between VibroSight software and VM600 XMx16 card hardware (that is, XMC16,
XMV16 and XMVS16 firmware).

NOTE: It is strongly recommended to use the most recent version of the VM600 CPUR
firmware and VM600 XMx16 firmware that is compatible with the version of
VibroSight software being used.

Document reference VIBROSIGHT-RN/E (660-010-013-228A)
VibroSight® 4.1.0 Version 28A —24.06.2019
36 /55



Enabling the Extraordinary 4
To Fly To Power To Live l

Table 1: VibroSight software and VM600 CPUR?2 firmware compatibility

See note 1

VM600 CPUR2 firmware

Base-system (*.tgz)

VibroSight software version 640-014-001-001 640-014-001-002 640-014-001-003
CD part number Applications (* . tgz)
640-015-001-001 640-015-001-002 640-015-001-003
2.12.7 v/ Seenote 2 v/ Seenote3 v

609-004-000-036

3.0.0 ‘/ \/ \/

609-004-000-037

3.1.0 ‘/ ‘/ ‘/

609-004-000-038

3.2.0 \/ ‘/ ‘/

609-004-000-039

3.3.0 \/ \/ \/

609-004-000-040

3.4.0 ‘/ ‘/ \/

609-004-000-041

35.0 \/ \/ \/

609-004-000-042

3.6.0 ‘/ ‘/ \/

609-004-000-043

3.7.0 \/ \/ ‘/

609-004-000-044

3.8.0 \/ \/ ‘/

609-004-000-045

4.0.0 ‘/ \/ \/

609-004-000-046

4.1.0 \/ \/ \/ See note 4

609-004-000-047

Notes for Table 1 (see the next page)
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Notes for Table 1

1. VM600 CPUR2 firmware is packaged and distributed as a .tgz file (a compressed archive file format) with PNRs such as 640-014-001-xxx for
the Base System and 640-015-001-xxx for the (Applications) Firmware. In these PNRs, the xxx-xxx-001-xxx denotes the firmware is packaged
in the tgz file format.

After the .tgz file is unpacked by VibroSight System Manager and the firmware is uploaded to a VM600 CPUR?2 card, the dialog box displayed
by the VibroSight System Manager's Change Firmware command shows the current version of firmware using PNRs such as 640-014-000-xxx
for the Base System and 640-015-000-xxx for the Firmware, which correspond to the actual unpacked firmware that is running on the card.

2. This is the first official release of VM600 CPUR2 firmware and includes features such as the management of XMx16 card configurations for
applications such as control systems and the implementation of the PROFIBUS protocol for the fieldbus interfaces. A firmware upgrade is
required in order to run VibroSight 2.12.7 or later.

3. This version of VM600 CPUR?2 firmware includes improvements such as changing the PROFIBUS polling rate for the Modbus server to
100 ms (was 200 ms) and a bug fix for a known VM600 CPUx time counter wraparound (overflow) issue. A firmware upgrade is strongly
recommended in order to run VibroSight 3.4.0 or later.

4. This version of VM600 CPUR?2 firmware includes improvements such as overall performance, responsiveness and stability, and support for
CPUR2/IOCR2 card pair relays, and the ability to download the GSD file directly from the card (see 2.3 CPUR2 card: new firmware for further
information). A firmware upgrade is strongly recommended but is not required in order to run VibroSight 4.1.0 or later.

Note: VibroSight 4.1.0 or later must be used in order to download the VM600 CPUR2 GSD file directly from the CPUR2 card.
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Table 2: VibroSight software and VM600 CPUR firmware compatibility

MEGGITT

VM600 CPUR firmware

See note 1

VibroSight software version

CD part number

Base-system (*.tgz)

640-011-001-004

640-011-001-005

Applications (* . tgz)

640-012-001-004

640-012-001-005

609-004-000-047

2127 ‘/ See note 2 ‘/
609-004-000-036

4.0.0 v \/
609-004-000-046

4.1.0 \/ \/ See note 3

Notes for Table 2

1. VM600 CPUR firmware is packaged and distributed as a .tgz file (a compressed archive file format) with PNRs such as 640-011-001-xxx for
the Base System and 640-012-001-xxx for the (Applications) Firmware. In these PNRs, the xxx-xxx-001-xxx denotes the firmware is packaged

in the tgz file format.

After the .tgz file is unpacked by VibroSight System Manager and the firmware is uploaded to a VM600 CPUR card, the dialog box displayed by
the VibroSight System Manager’'s Change Firmware command shows the current version of firmware using PNRs such as 640-011-000-xxx for
the Base System and 640-012-000-xxx for the Firmware, which correspond to the actual unpacked firmware that is running on the card.

2. This is the latest official release of VM600 CPUR firmware (that is, the earlier version of the CPUx card with support for card pair redundancy
(PNR 600-007-000-VVV)), which was discontinued in VibroSight 2.12.0 and reintroduced in VibroSight 4.0.x).

3. This version of VM600 CPUR firmware includes a bug fix for a known VM600 CPUXx time counter wraparound (overflow) issue and the
addition of relay outputs to the diagnostics logs (see 2.4 CPUR card: new firmware for further information). A firmware upgrade is strongly
recommended but is not required in order to run VibroSight 4.1.0 or later.
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Table 3: VibroSight software and VM600 XMx16 firmware compatibility

VMB00 XMx16 firmware 5°¢"°'¢*
Base-system (*.tgz)
640-003- 640-003- 640-003-
VibroSight software version 001-013 001-014 001-016
CD part number Applications (* . tgz)
640-010- 640-010- 640-010-
001-013 001-014 001-016
2127 \/ See note 2
609-004-000-036
3.0.0 ‘/ See note 3
609-004-000-037
3.1.0 v
609-004-000-038
3.2.0 \/
609-004-000-039
3.3.0 \/ See note 4
609-004-000-040
3.4.0 \/
609-004-000-041
3.5.0 \/
609-004-000-042
3.6.0 ‘/
609-004-000-043
3.7.0 ‘/
609-004-000-044
3.8.0 ‘/
609-004-000-045
4.0.0 ‘/
609-004-000-046
4.1.0 ‘/
609-004-000-047

Notes for Table 3 (see the next page)
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Notes for Table 3

1. VM600 XMx16 firmware is packaged and distributed as a .tgz file (a compressed archive file format) with PNRs such as 640-003-001-xxx for
the Base System and 640-010-001-xxx for the (Applications) Firmware. In these PNRs, the xxx-xxx-001-xxx denotes the firmware is packaged
in the tgz file format.

After the .tgz file is unpacked by VibroSight System Manager and the firmware is uploaded to a VM600 XMx16 card, the dialog box displayed by
the VibroSight System Manager's Change Firmware command shows the current version of firmware using PNRs such as 640-010-000-xxx for
the Firmware and 640-003-000-xxx for the Base System, which correspond to the actual unpacked firmware that is running on the card.

2. This version of VM600 XMx16 firmware improves support for faster live data: 100 ms card update rate and up to 100 ms VibroSight Vision
refresh rate. It also allows a VM600 XMx16 card to be managed by a VM600 CPUR card (“rack controller”), eliminating the XMx16 card’s
requirement for a VibroSight Server. A firmware upgrade is required in order to run VibroSight 2.12.7.

3. This version of VM600 XMx16 firmware adds support for customer-specific functionality that is enabled by a customer-specific VibroSight
software license. A firmware upgrade is required in order to run VibroSight 3.0.0 or later.

4. This version of VM600 XMx16 firmware includes relaxed constraints for dynamic data retention time, that is, optimised memory to reduce the
possibility of missing data in data intensive VibroSight applications running on less powerful computers. A firmware upgrade is required in order
to run VibroSight 3.3.0 or later.
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6.2.2 VibroSmart device firmware

The latest VibroSmart device firmware files are copied to a directory on your computer as part of the VibroSight
software installation process.

NOTE: The default firmware directory for VibroSmart devices is:
C:\Program Files\Meggitt\VibroSight\Firmware\VibroSmart

The firmware files for a VibroSmart device can be found in the appropriate subfolder and identified by their .*fw file
name extension. For example, the vsv30x subfolder contains the firmware for use by VSV30x modules. Any
additional firmware updates received from Meggitt SA should also be stored in these directories.

Table 4 shows the compatibility between VibroSight software and the VibroSmart VSI010 firmware.
Table 5 shows the compatibility between VibroSight software and the VibroSmart VSNO10 firmware.

Table 6 shows the compatibility between VibroSight software and the VibroSmart VSV30x firmware.

NOTE: It is strongly recommended to use the most recent version of the VibroSmart
firmware that is compatible with the version of VibroSight software being used.
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Table 4: VibroSight software and VibroSmart VSI010 firmware compatibility

VSIO10 firmware (* . xmsifw) %" *
VibroSight software version
642-002-000-009 642-002-000-010
CD part number

2.12.7 ‘/ See note 2 ‘/See notes
609-004-000-036 2and3

3.00 v v
609-004-000-037

3.1.0 v v
609-004-000-038

3.2.0 v v
609-004-000-039

3.3.0 v v
609-004-000-040

3.4.0 v v
609-004-000-041

3.5.0 v v
609-004-000-042

3.6.0 v v
609-004-000-043

3.7.0 v v
609-004-000-044

3.8.0 v v
609-004-000-045

4.0.0 v v
609-004-000-046

4.1.0 \/ \/
609-004-000-047

Notes for Table 4 (see the next page)
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Notes for Table 4

1. VibroSmart VSI010 firmware is distributed as a single .xmsifw file (a proprietary file format) with a PNR such as 642-xxx-000-xxx. In these
PNRs, the xxx-xxx-000-xxx denotes that the firmware is not packaged (compressed or archived). VibroSight System Manager always uses and
displays information about VibroSmart device firmware using PNRs such as 642-xxx-000-xxx, which correspond to the actual firmware that is
running on the device.

2. Updating to this version of VibroSmart VSI010 firmware requires a specific process:
Notes:

For a VibroSmart consisting of different types of device, the devices should be updated in the following order: first VSNO10 real-time Ethernet
switches, then VSV30x vibration monitoring modules and finally VSI010 communications interface modules. In addition, VibroSight System
Manager should be exited (closed) and restarted after updating the firmware for each type of device, before continuing. And after updating the
firmware, the configuration on the VibroSmart devices should be re-applied (re-activated) and the VibroSmart devices should be restarted.

Procedure:

(1) Ensure that a copy of the configuration for the VibroSmart is available before updating any device firmware. For example, using the currently
installed version of VibroSight (that is, before any updates to the VibroSight software corresponding to updates to VibroSmart devices),
VibroSight Configurator can be used to obtain a copy of the configuration as follows:

« For a VibroSmart using a VibroSight Server, the File > Open > Server / Database command can be used to read the configuration from the
VibroSight Server.

» For a VibroSmart not using a VibroSight Server (that is, a “stand-alone” VibroSmart), the File > Open > Device command can be used to read
the configuration directly from the VibroSmart modules.

Then the File > Save As > File command can be used to store a copy of the configuration for the VibroSmart.

(2) Start VibroSight System Manager, select the device or devices of the same type to be updated (for example, VSI010 modules) and run the
Change Firmware command.

When updating multiple VibroSmart devices of the same type to use the same firmware, CTRL+click or SHIFT+click can be used to select
multiple devices in the Devices tree structure of the System Explorer window. This way, when the Change Firmware command is run, all of
devices that were selected will be updated at the same time. Otherwise, each device must be selected and updated individually.

(3) When the VibroSmart Module(s) Firmware Upgrade window displays a “Firmware upgrade terminated. The firmware has been upgraded
successfully ...” message, click the Finish button to continue.

If after 10 minutes, the VibroSmart Module(s) Firmware Upgrade window does not display a successful message, click the Cancel button to
close the window and continue.

Then exit (close) VibroSight System Manager.

(4) Restart VibroSight System Manager and verify that the correct version of firmware is reported for each device that was updated. (When a
device is selected in the System Explorer window, this information is available in the main window (centre) under Module PNR. It is also
available in the VibroSmart Module(s) Firmware Upgrade window when a device is selected and the Change Firmware command is run).

If a device does not report the correct version of firmware, rerun the Change Firmware command for this device.

Then exit (close) VibroSight System Manager.

(5) Repeat steps (2), (3) and (4) for each type of device to be updated (for example, VSN010 and VSV30x modules).

(6) Start VibroSight Configurator, open the configuration for the VibroSmart (see step (1)), then apply (activate) the configuration. (If required,
VibroSight Configurator will automatically update the configuration to the latest version and inform the user.)
Then exit (close) VibroSight Configurator.

(7) Turn the power supply to the VibroSmart off and wait for a few seconds. Then turn the power supply back on and verify that the system
operates as expected.

During this firmware update process, the behaviour of the LEDs on the front panel of the VibroSmart devices can be inconsistent and should be
ignored. Normal LED behaviour resumes after the firmware update is complete (after step (7)).

3. This version of VibroSmart VSI010 firmware has no limit on the number of constants per VSI010 module.
A firmware upgrade is recommended but is not required in order to run VibroSight 3.8.0 or later.
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Table 5: VibroSight software and VibroSmart VSNO10 firmware compatibility

MEGGITT

VSNO10 firmware (* . redboxfw)

Seenote 1

VibroSight software version

CD part number

642-004-000-011

2127 ‘/See note 2
609-004-000-036

3.00 v
609-004-000-037

3.1.0 v
609-004-000-038

3.20 v
609-004-000-039

3.3.0 v
609-004-000-040

3.4.0 \/
609-004-000-041

3.5.0 v
609-004-000-042

3.6.0 v
609-004-000-043

3.7.0 ‘/
609-004-000-044

3.8.0 v
609-004-000-045

4.0.0 \/
609-004-000-046

4.1.0 v

609-004-000-047

Notes for Table 5 (see the next page)
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Notes for Table 5

1. VibroSmart VSNO10 firmware is distributed as a single .redboxfw file (a proprietary file format) with a PNR such as 642-xxx-000-xxx. In these
PNRs, the xxx-xxx-000-xxx denotes that the firmware is not packaged (compressed or archived). VibroSight System Manager always uses and
displays information about VibroSmart device firmware using PNRs such as 642-xxx-000-xxx, which correspond to the actual firmware that is
running on the device.

2. Updating to this version of VibroSmart VSNO010 firmware requires a specific process:
Notes:

For a VibroSmart consisting of different types of device, the devices should be updated in the following order: first VSNO10 real-time Ethernet
switches, then VSV30x vibration monitoring modules and finally VSI010 communications interface modules. In addition, VibroSight System
Manager should be exited (closed) and restarted after updating the firmware for each type of device, before continuing. And after updating the
firmware, the configuration on the VibroSmart devices should be re-applied (re-activated) and the VibroSmart devices should be restarted.

Procedure:

(1) Ensure that a copy of the configuration for the VibroSmart is available before updating any device firmware. For example, using the currently
installed version of VibroSight (that is, before any updates to the VibroSight software corresponding to updates to VibroSmart devices),
VibroSight Configurator can be used to obtain a copy of the configuration as follows:

« For a VibroSmart using a VibroSight Server, the File > Open > Server / Database command can be used to read the configuration from the
VibroSight Server.

» For a VibroSmart not using a VibroSight Server (that is, a “stand-alone” VibroSmart), the File > Open > Device command can be used to read
the configuration directly from the VibroSmart modules.

Then the File > Save As > File command can be used to store a copy of the configuration for the VibroSmart.

(2) Start VibroSight System Manager, select the device or devices of the same type to be updated (for example, VSNO010 modules) and run the
Change Firmware command.

When updating multiple VibroSmart devices of the same type to use the same firmware, CTRL+click or SHIFT+click can be used to select
multiple devices in the Devices tree structure of the System Explorer window. This way, when the Change Firmware command is run, all of
devices that were selected will be updated at the same time. Otherwise, each device must be selected and updated individually.

(3) When the VibroSmart Module(s) Firmware Upgrade window displays a “Firmware upgrade terminated. The firmware has been upgraded
successfully ...” message, click the Finish button to continue.

If after 10 minutes, the VibroSmart Module(s) Firmware Upgrade window does not display a successful message, click the Cancel button to
close the window and continue.

Then exit (close) VibroSight System Manager.

(4) Restart VibroSight System Manager and verify that the correct version of firmware is reported for each device that was updated. (When a
device is selected in the System Explorer window, this information is available in the main window (centre) under Module PNR. It is also
available in the VibroSmart Module(s) Firmware Upgrade window when a device is selected and the Change Firmware command is run).

If a device does not report the correct version of firmware, rerun the Change Firmware command for this device.

Then exit (close) VibroSight System Manager.

(5) Repeat steps (2), (3) and (4) for each type of device to be updated (for example, VSI010 and VSV30x modules).

(6) Start VibroSight Configurator, open the configuration for the VibroSmart (see step (1)), then apply (activate) the configuration. (If required,
VibroSight Configurator will automatically update the configuration to the latest version and inform the user.)

Then exit (close) VibroSight Configurator.

(7) Turn the power supply to the VibroSmart off and wait for a few seconds. Then turn the power supply back on and verify that the system
operates as expected.

During this firmware update process, the behaviour of the LEDs on the front panel of the VibroSmart devices can be inconsistent and should be
ignored. Normal LED behaviour resumes after the firmware update is complete (after step (7)).
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Table 6: VibroSight software and VibroSmart VSV30x firmware compatibility

MEGGITT

VSV30x firmware (* .xtranfw)

See note 1

VibroSight
software version
CD part number

642-001-000-014

642-001-000-015

642-001-000-016

2.12.7
609-004-000-036

‘/ See note 2

3.0.0
609-004-000-037

3.1.0
609-004-000-038

3.2.0
609-004-000-039

3.3.0
609-004-000-040

3.4.0
609-004-000-041

‘/ See notes

2and 3

\/ See notes

2and 4

3.5.0
609-004-000-042

v

v

3.6.0
609-004-000-043

3.7.0
609-004-000-044

3.8.0
609-004-000-045

4.0.0
609-004-000-046

4.1.0
609-004-000-047

Notes for Table 6 (see t

he next page)
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Notes for Table 6

1. VibroSmart VSV30x firmware is distributed as a single .xtranfw file (a proprietary file format) with a PNR such as 642-xxx-000-xxx. In these
PNRs, the xxx-xxx-000-xxx denotes that the firmware is not packaged (compressed or archived). VibroSight System Manager always uses and
displays information about VibroSmart device firmware using PNRs such as 642-xxx-000-xxx, which correspond to the actual firmware that is
running on the device.

2. Updating to this version of VibroSmart VSV30x firmware requires a specific process:
Notes:

For a VibroSmart consisting of different types of device, the devices should be updated in the following order: first VSNO10 real-time Ethernet
switches, then VSV30x vibration monitoring modules and finally VSI010 communications interface modules. In addition, VibroSight System
Manager should be exited (closed) and restarted after updating the firmware for each type of device, before continuing. And after updating the
firmware, the configuration on the VibroSmart devices should be re-applied (re-activated) and the VibroSmart devices should be restarted.

Procedure:

(1) Ensure that a copy of the configuration for the VibroSmart is available before updating any device firmware. For example, using the currently
installed version of VibroSight (that is, before any updates to the VibroSight software corresponding to updates to VibroSmart devices),
VibroSight Configurator can be used to obtain a copy of the configuration as follows:

« For a VibroSmart using a VibroSight Server, the File > Open > Server / Database command can be used to read the configuration from the
VibroSight Server.

» For a VibroSmart not using a VibroSight Server (that is, a “stand-alone” VibroSmart), the File > Open > Device command can be used to read
the configuration directly from the VibroSmart modules.

Then the File > Save As > File command can be used to store a copy of the configuration for the VibroSmart.

(2) Start VibroSight System Manager, select the device or devices of the same type to be updated (for example, VSV30x modules) and run the
Change Firmware command.

When updating multiple VibroSmart devices of the same type to use the same firmware, CTRL+click or SHIFT+click can be used to select
multiple devices in the Devices tree structure of the System Explorer window. This way, when the Change Firmware command is run, all of
devices that were selected will be updated at the same time. Otherwise, each device must be selected and updated individually.

(3) When the VibroSmart Module(s) Firmware Upgrade window displays a “Firmware upgrade terminated. The firmware has been upgraded
successfully ...” message, click the Finish button to continue.

If after 10 minutes, the VibroSmart Module(s) Firmware Upgrade window does not display a successful message, click the Cancel button to
close the window and continue.

Then exit (close) VibroSight System Manager.

(4) Restart VibroSight System Manager and verify that the correct version of firmware is reported for each device that was updated. (When a
device is selected in the System Explorer window, this information is available in the main window (centre) under Module PNR. It is also
available in the VibroSmart Module(s) Firmware Upgrade window when a device is selected and the Change Firmware command is run).

If a device does not report the correct version of firmware, rerun the Change Firmware command for this device.

Then exit (close) VibroSight System Manager.

(5) Repeat steps (2), (3) and (4) for each type of device to be updated (for example, VSI010 and VSN010 modules).

(6) Start VibroSight Configurator, open the configuration for the VibroSmart (see step (1)), then apply (activate) the configuration. (If required,
VibroSight Configurator will automatically update the configuration to the latest version and inform the user.)

Then exit (close) VibroSight Configurator.

(7) Turn the power supply to the VibroSmart off and wait for a few seconds. Then turn the power supply back on and verify that the system
operates as expected.

During this firmware update process, the behaviour of the LEDs on the front panel of the VibroSmart devices can be inconsistent and should be
ignored. Normal LED behaviour resumes after the firmware update is complete (after step (7)).

3. This version of VibroSmart VSV30x firmware introduces support for hydro air-gap monitoring.
A firmware upgrade is required in order to run VibroSight 3.4.0 or later.

4. This version of VibroSmart VSV30x firmware introduces support for latched alarms.
A firmware upgrade is recommended but is not required in order to run VibroSight 3.6.0 or later.
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6.2.3 Updating the firmware using VibroSight System Manager

When performing VibroSight software upgrades, it is strongly recommended to systematically upgrade the firmware
of VM600 XMx16 cards and VibroSmart devices to the latest compatible version.

Failure to perform a necessary VibroSight-compatible VM600 card firmware update may lead to incoherent system
behaviour and affect the proper functioning of data acquisition in a system. It is only in systems where the firmware
running on the XMx16 cards and VibroSmart devices already corresponds to the latest available version that no
firmware update is required. Therefore, it is strongly recommended to verify the version of firmware running on the
hardware before starting a VibroSight system upgrade, in order to establish if a firmware update is also required.

NOTE: Changing the firmware of the VibroSight hardware is a special administrative task
that can — if performed unintentionally — affect the proper functioning of data
acquisition in a system.

It is therefore strongly recommended to change the firmware of the VibroSight
hardware only when it is necessary. For example, when the devices must be
updated to be compatible with a VibroSight software upgrade.

For VibroSmart modules, each module can be selected and its firmware updated individually. Alternatively, multiple
modules of the same type (for example, VSV3x0) can be updated to the same version of firmware at the same
time.

NOTE: It is strongly recommended to ensure that a copy of the configuration for a
VibroSmart is available before updating the firmware of any of the VibroSmart
modules used in the distributed monitoring system.

For example, using the currently installed version of VibroSight (that is, before any
updates to the VibroSight software corresponding to updates to VibroSmart
modules), VibroSight Configurator should be used to obtain a copy of the
configuration as follows:

For a VibroSmart using a VibroSight Server, the File > Open > Server / Database
command can be used to read the configuration from the VibroSight Server.

For a VibroSmart not using a VibroSight Server (that is, a “stand-alone”
VibroSmart), the File > Open > Device command can be used to read the
configuration directly from the VibroSmart modules.

Then the File > Save As > File command should be used to store a copy of the
configuration for the VibroSmart distributed monitoring system.

Update the firmware on a VibroSight device using the |j Change Firmware tool (from VibroSight System
Manager’s Maintenance tools):

1. Ensure that the computer running the VibroSight software is on the same network as the hardware (XMx16
card or VibroSmart module or device) to be updated.

2. Start VibroSight System Manager and navigate to the Devices tree structure in the System Explorer window.
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The Devices tree lists all of the VibroSight compatible hardware that VibroSight can see on the network. If
there are no XMx16 cards or VibroSmart devices in the tree structure or some cards are missing, verify your
network connections.

3. Select the card or device that requires its firmware to be changed.
The Actions tool window updates to show the available tools.

To change multiple VibroSmart to use the same version of firmware at the same time, use CTRL+click or
SHIFT+click to select multiple devices from the Devices tree-view. (Then, when the Change Firmware
command is run, all of the devices that were selected will be updated at the same time.)

4. Click |j Change Firmware in the Maintenance tools group of the Actions window.
The Change Firmware dialog box appears.

5. Click the Add button and select the new firmware files for the card or new firmware file for the device.

NOTE: The Change Firmware dialog box automatically opens the firmware folder
corresponding to the VibroSight-compatible VM600 card or VibroSmart device
selected.

. tgz files are for VM600 cards and . * fw files are for VibroSmart devices.

6. Click the Finish button to start the firmware upgrade process.

For XMx16 cards and VibroSmart devices, the firmware upgrade process can take up to 5 minutes, during
which:

e The IP address beside the device’s serial number in the Devices tree structure can disappear.
e The LEDs on the front panel of the device can change to reflect the status of the upgrade.

7. Repeat steps 3 to 6 for each device that requires a firmware update.

NOTE: Although the firmware for each VibroSight device must be changed individually

using the |j Change Firmware tool, as each device updates its firmware
independently of the VibroSight software (once the process has started), firmware
updates can be performed on several devices in parallel.

8. After the firmware upgrade, verify that the VibroSight system is acquiring data from the cards.

NOTE: Refer also to the Changing the firmware topics in the @ VibroSight help.

The |j Change Firmware tool can be used to load a VibroSight device with any version of firmware. It is
therefore possible to change a device’s firmware to any previously available version, as well as the latest update.
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This feature can be useful in certain situations, for example, swapping spare VibroSight hardware between different
VMB600 racks or VibroSmart distributed monitoring systems, where systems are operating with different versions of
VibroSight.

6.3 Final checks

After upgrading the VibroSight software, it is recommended to check that VibroSight has not been inadvertently
modified and that it continues to operate normally.

In particular, it is recommended to check any VibroSight Servers in order to ensure that the data acquisition and
external interfaces, data post-processing and/or logging are all configured as expected.

In a VibroSight Server user interface:

e On the Status tab under Device drivers, check that the VM600, VibroSmart, OPC and Modbus controls are
enabled or disabled as required by your application.

e On the Status tab under Server features, check that the Basic math, Air gap, Combustion monitoring, Duration
counters, VSHDA import and Data logging manager controls are enabled or disabled as required by your
application.

e On the Log messages tab, check the listed messages (Info level) to ensure that the hardware (VM600 cards
and /or VibroSmart modules) have been discovered and that data acquisition has resumed.

NOTE: When a VibroSight Server is running as a Windows service, the usual VibroSight
Server user interface is not displayed, so VibroSight System Manager must be
used to work with the VibroSight Server.

That is, VibroSight System Manager can be used to connect to a VibroSight Server
in order to check and configure the operation of the server’s drivers and features.

Finally, after an upgrade, it is strongly recommended to use VibroSight Vision to connect to any VibroSight Servers
in order to verify that new live and/or historical data is available.
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7 Customer support

7.1 Contacting us

Meggitt SA worldwide customer support network offers a range of support including Technical support and Sales
and repairs support. For customer support, please contact your local Meggitt representative. Alternatively, contact
our main office:

Customer support
Meggitt SA
Route de Moncor 4
PO Box 1616
CH-1701 Fribourg
Switzerland

Telephone: +41 (0) 26 407 11 11
Email: energysupport@ch.meggitt.com
Website: www.meggittsensing.com/energy

7.2 Technical support

Meggitt SA technical support team provide both pre-sales and post-sales technical support, including:
e General advice
e Technical advice
e Troubleshooting

e Site visits.

7.3 Sales and repairs support

Meggitt SA sales team provide both pre-sales and post-sales support, including advice on:
¢ New products
e Spare parts

e Repairs.
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Appendix
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VibroSight software and Windows operating system compatibility

Windows 10 Windows 8.1 Windows 7

Yes
(but not recommended for new
installations as Microsoft support for
Windows 7 ends in January 2020)

VibroSight software compatible? Yes Yes

VibroSight software and Windows Server operating system compatibility

Windows Server 2016 Windows Server 2012 Windows Server 2008 R2

Yes
(but not recommended for new
VibroSight software compatible? Yes Yes installations as Microsoft support for
Windows Server 2008 R2 ends in
January 2020)
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VibroSight software and Microsoft .NET Framework requirements

VibroSight software version Microsoft .NET Framework requirements
VibroSight 3.7.0 or later NET Framework 4.7.2 S "1
VibroSight 3.4.0 or later NET Framework 4.7.1 ¢¢ "2
VibroSight 3.0.0 or later .NET Framework 4.6
VibroSight 2.12.0 or later NET Framework 4.5 and .NET Framework 2.0 5% "¢ 3
VibroSight 2.9.4 or later .NET Framework 4.5
VibroSight 2.9.3 and 2.9.2 .NET Framework 4 (Standalone Installer)
VibroSight 2.9.1 or earlier .NET Framework 3.5 SP1
Notes

1. Microsoft .NET Framework 4.7.2 replaces .NET Framework versions 4.0 to 4.7.1.
2. Microsoft .NET Framework 4.7.1 replaces .NET Framework versions 4.0 to 4.7.

3. Since Microsoft .NET Framework 3.5 also includes .NET Framework 2.0 and .NET Framework 3.0, installing Microsoft .NET Framework 3.5 SP1 is the recommended solution for most computers (rather than

installing Microsoft .NET Framework 2.0).
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